
Analysis of Photonic Crystal Fibers (PCF) in OptiFDTD 
 
 
Introduction 
 
In the past 10 years, photonic crystal fibers (PCF) have attracted much scientific and 
commercial interest.  The research and design work for PCF starts from accurate modal 
analysis of the fiber. Once the modes are found, all of the PCF properties such as loss, 
dispersion, and cutoff can be determined. 
 
There are general three types of PCF: holey fiber (HF), field-confined holy fiber (FCHF) 
and Hole-Assisted Light-guide Fiber (HALF), as shown in figure 1. 
 
In OptiFDTD, the mode solver is combined with the FDTD engine so that FDTD 
simulation can use the modal field as input directly. In addition to this integrated mode 
solver, OptiFDTD also provides an independent mode solver to allow user to solve and 
study the mode outside of an FDTD calculation. The PCF mode solvier will mainly be 
used as an independent mode solver.   Modal analysis requires two main steps: 

(1) Create the layout 
(2) Calculate the modes 

We will use waveguide layout designer to define the PCF layout, and then convert the 
layout to a refractive index distribution file. The mode solver will load in the index 
distribution file and perform the mode analysis. 
 
Some users may want to scan the wavelength to find out the cutoff wavelength, or want 
to scan the layout parameters. All of this is possible with OptiFDTD 
 
The following section will demonstrate how a photonic crystal fiber can be analyzed in 
OptiFDTD.   
 
Sample 1---Photonic Crystal Fiber---Holey Fiber  
 
The most common PCF is Holey Fiber as shown in figure 1 (a), the cladding region 
consists of a hexagonal array of air-holes; One missing air-hole defines the core region. 
The real layout may have more layers of air holes, but it is sufficient to model only three 
layers since the mode is well confined [2].  To be safe, here we take five layers for the 
mode solving. We use the PBG array editor to define the hexagonal air hole. To make the 
core center in the simulation domain’s center, we need to draw a graph (see figure 2) so 
that the detail dimension information can be marked. Such a graph can make the layout 
creation easier, so it is highly recommended. 
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Figure 2 Five layers holey fiber 

 
Please note: 
 
 For this five layer holey fiber 

(a) The background material refractive index n = 1.46 
(b) Hexagonal Air hole, periodic a = 2.3um, n = 1.0, radius R = 0.6um 
(c) Simulation momain, z = 11*a, x = 11*a*sin(60º) 
(d) The green dot is the hexagonal lattice original point x = -5*a*sin(60o); z = 0 

 
i. Create the layout  

 
To design a holey fiber structure, perform the following procedures. 

Step  Action 
1  Start Waveguide Layout Designer. 
2  To create a new project, select File > New. 

The Initial Properties dialog box appears. 
3  Click Profiles and Materials. 

The Profile Designer window appears. 
4  Under the Materials folder, right-click the FDTD-Dielectric folder and select 

New. 
A new Dielectric material dialog box appears. 

5  Type the following information: 
Name: n=1.46 
Refractive index (Re:): 1.46 

6  To save the material, click Store. 
N=1.46 appears in the FDTD-Dielectric folder in the directory and in the 
dialog box title bar. 

7 Under the Profiles folder, right-click the Channel folder and select New. 



The ChannelPro1 dialog box appears. 
8 Create the following channel profile: 

Profile name: Channel_Air 
2D profile definition 
Material: Air 

9  Click Store. 
(Close the Profile Designer.or leave it open) 

10 In the Initial Properties dialog box, , type/select the following: 
Waveguide Properties 
Width [µm]: 0.6 
Profile: Channel_Air 
Wafer Dimensions 
Length: length 
Width: width 
2D Wafer Properties 
Material: n=1.46 

10 Click OK in the initial dialog box. Click Yes in the question dialog box to start 
define the variable. Variables and Functions dialog box appears 
Because variable (length, width) is used in the initial dialog box .Click OK will 
promote the parameter editor dialog box  

11 In the Variables and Functions dialog box appears, define the following variable 
in sequence then click OK to close the dialog box 

Name  value    
a   2.3um   ~lattice constant 

 b  a*sin(pi/3)  ~height of triangle cell 
 length  11*a   ~length of domain 
 width  11*b   ~width of domain 
 c  -5*b   ~X original point of lattice 
 R  0.6um   ~Radius of air hole 

 
Figure 3 Variable and function dialog box 

 
Notes: you can access Variables and functions dialog box in 
anytime by Select “Edit Parameters” under Simulation menu of 
layout designer 



 
 

 
  

12. From the Draw menu, select PBG Crystal Structure. 
13. Click mouse once in the layout window, The PBG Crystal Structure appears in 

the layout window (see Figure 4). Click select tool ( the arrow shortcut toolbar) to 
release the PBG selection. 

. 

 
 

Figure 4 Layout window with initial PBG layout 
 

14 To edit the crystal structure, double-click on the PBG structure (a rectangular shape) 
in the layout. The Crystal Lattice Properties dialog box appears (Figure 5). 



 
 

Figure 5 Crystal Lattice properties dialog box 
 
 
 
15 In the Crystal Lattice Properties dialog box, Set the following parameter 
 

Origin 
 Horizontal, expression: 0 
 Horizontal Offset:  0 
 Vertical Expression:  c 
 Vertical Offset:   0 
 
Depth:  0.0 
Azimuth: 0.0 
 
Lattice Properties: 
  Type:    2D Hexagonal 
  Fill:   Block 
  Lattice Dimension: 
   Scale: a 
   #A 11 
   #C 12 
 

16 In Atom Waveguide in Unit Cell, Add New, select Elliptic Waveguide from the 
drop-down menu and click New. The Elliptic Waveguide Properties dialog box 
appears (see Figure 6).  In  Elliptic Waveguide Properties dialog box set following 
value 

 
In Center, Offset, type/select the following: 



Horizontal: 0.0 
Vertical: 0.0 
Type/select the following: 
Major radius: 0.6 
Minor radius: 0.6 
Orientation angle: 0.0 
Channel thickness tapering: Use Default (Channel: None) 
Depth: 0.0 
Label: Atom 
Profile: Channel_Air. 
 
Click OK. 
The Elliptic Waveguide Properties dialog box closes. 
 

 
 

Figure 6 Elliptic Waveguide Properties dialog box 
 



Note: When you return to the Crystal Lattice Properties dialog box, you will see the 
defined elliptic waveguide listed in Atom Waveguide in Unit Cell. 
Note: If you close the Crystal Lattice Properties dialog box, you will see the defined 
PBG structure in the layout window (see Figure 7). 

 

 
 

Figure 7 PBG layout in designer window 
 
 
 
17 In the layout designer, to select the PBG lattice, click the PBG area. The PBG 

Crystal Structure Cell Editing Tool (a shortcut toolbar beside the Arrow select tool 
as shown in figure 8)  becomes active. Select this shortcut tool bar.,   When this tool 



is selected, right click on the photonic cell and click “Cells Off” to disable the cells. 
With this step, a five layer Holey fiber can be realized (see figure 9.) 

18  
 

 
 

Figure 8 shortcut toolbar for PBG Crystal Structure Cell Editing Tool  
 

 
 

Figure 9 Five layers holey fiber 
 



19 To observe the index distribution, please set a point source in the layout. The center 
Wavelength is 1.3um with Gaussian Modulated Continuous Wave as time domain 
waveform 

20 Click 2D Simulation Parameters under Simulation menu, set following parameters 
and Click OK. 

 
Mesh Delta X:  0.08um 
Mesh Delta Z:  0.08um 
Run for 1  time steps 
 
 

21 Click 2D Refr_Idx_Re(y) to observe the refractive index distribution. ( see figure 10) 
 
 

 
 

Figure 10   Refractive index distribution 
 



ii. Convert Refractive index distribution to a file 
 
Because we will use the independent mode solver to solve the mode, we have to save the 
refractive index distribution to a file. In the current version of OptiFDTD, the option to 
save the refractive index distribution to file only exists in the analyzer. We have to 
perform a short simulation so that all the data is written to an analyzer file. (In the next 
release, there will be the option to save the refractive index distribution directly from the 
layout designer). 
 
 

Step  Action 
1 Set an input wave (with Gaussian Modulated Continuous Wave as time domain 

waveform) in the layout, (This work was done in step 19 in a previous section). 
2 Set proper mesh size for mode solving (This work was done in step 19 in a 

previous section) 
3 Set time domain simulation iteration number as 1.  (This work was done in step 

19 in a previous section) 
4 Perform the 2D simulation. After the simulation, open the analyzer. 
5 In the Analyzer, Click Export under file menu.  

Export data dialog box appears (see figure 11) 

 
Figure 11 Export data dialog box 

 
6 Check Ref.Idx Box and click “…” button to set the file name and folder 

The file name is PCF_Holey_Fiber_five_layers01.rid in this tutorial. Click Export 
to export data. Click Close button to close the dialog box 

 
iii. Perform the Mode analysis  



 
Step  Action 

1 To open Independent 3D Mode Solver, from the Start menu, select 
Programs > Optiwave Software > OptiFDTD 6.0 > Tools > Mode 3D 
. 3D Mode solver appears (see Figure 12) 

 
 

Figure 12 3D Mode Solver 
 

2 Click “New” under file menu and select “User Defined File” and click 
OK in the pop up window. 

3 Click Brose button to load in the refractive index file 
(PCF_Holey_Fiber_five_layers01.rid--- in this tutorial )  

4 Click Simulation menu and select ADI Method under Global 
Parameters.   Global Data:ADI Method dialog appears ( see Figure 
13) 



 
 

Figure 13 Global data: ADI Method dialog box 
 
 

5 In the Global data: ADI Method dialog box, type the following value, 
then click OK button to close the dialog box 

 
Wavelength:  1.3um 
Number of Modes: 1 
 
General: 

Solver:    Complex 
Mode:  Full Vector 

   Initial Excitation:  Along X 
 Waveguide: Straight 
 
Setting: 
 Start Field: Gaussian 
 Accuracy:  
   Index Tolerance: 1E-007 
   Field Tolerance: 1E-005 
 Boundary Condition: TBC 
 
Notes:  Other setting follows the default 
  
     



6 Select “Calculate ADI” under simulation menu. Click Run button to 
start the mode analysis. 3D mode solver resulting window appears 
(see figure 14).   
 
The layout will be fist displayed, once the mode is solved (after a 
while), the display will be modal filed. (Click Display under Structure 
View will display the layout again) 
 
Notes: 
(1) save the field pattern by click Save As button 
(2) Save the modal index by click “Save Table 
(3) Click Close in the file menu to close this window  

 

 
 

Figure 14  3D mode solver results window 
 
 
 

 
iv.   Perform the wavelength scanning mode analysis  

 
 
Step  Action 

1 In the 3D Mode Solver Window, click Edit Parameters under Simulation 
menu. Edit Parameter dialog box appears (see figure 15). 



 
 

Figure 15  Edit Parameters dialog box 
 
2 In the Edit Parameter dialog box, in Name box, input “wavelength” and set 

value as 0.8, Click Add/Apply button to make the defined variable to be 
listed.  Click Close to close the dialog box 

3 Click Scan Parameters under Simulation menu. Scan parameters dialog box 
appears (see figure 16). 



 
 

Figure 16 Scan Parameters dialog box 
4 Select “wavelength” under Unassigned Parameters table, Click Add button 

to add variable wavelength as the scan parameter.  Parameters wavelength will 
be listed in the bottom table. 

5 Set Number of Iteration as 31 and click apply button.  The wavelength table 
will be extent to 31 lines. 

6 Click Assign button,  parameter wavelength will be set as Leading 
Parameter 

7 In the wavelength table, click “wavelength”, the whole wavelength column 
will be selected.  Under wavelength column, in the line 31, Double click the 
box.  And input iteration end value 1.4 

8 Re-select the wavelength column, click Fill button will automatic generate the 
sampling point for each sweep wavelength value. 

9 Click OK to close this Scan Parameter dialog box 
10 Click Calculate ADI under simulation menu. In the Wavelength box input 

parameters name “wavelength”, select Full vector with initial excitation along 
Y. Set Complex Solver with boundary condition as TBC. Run the simulation 
will start the wavelength scan simulation, the cutoff wavelength can be 
obtained in this manner ( see figure 17) 

 



 
 

Figure 17 monitor the wavelength scan simulation 


